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Startup @1

TI-Nspire™ Navigator™ System Startup

Each handheld must have its latest available OS version installed to
enable wireless connectivity.

Disconnect the access point from the computer.

If the access point is connected to the computer, please dizconnect it
now before connecting your TI-Nspire™ handhelds.

Connect your TI-Nspire™ CX handhelds.

Connect the TH-Nspire™ handhelds to the computer with a docking station
or USB cable, and press the "Detect Handheld OS” button to determine if
handheld 0S updates are required. NOTE: It may take several seconds
after connecting handhelds for the "Detect Handheld OS" button to
become available.

TIP: If you cannot connect all handhelds to the computer at one time,
connect as many handhelds as possible and update the OS on those
handhelds. After the OS update is complete, disconnect the handhelds and
repeat the OS update process until all handhelds are updated

{1 Each handheld has its latest available OS version.|
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Add to Transfer List &J

( Setup | Status

File Name Folder / HandheldID Status
™ TI-NspireCXCAS-#.#.#... Ti-Nspire™ Operating Sy.. 0 of 10
[ TI-NspireCXCAS-#.#... @ 1008000007206D3C3C04... | [
[ TI-NspireCXCAS-#.#... @ 1008000007206D3C3C04... |
[T TI-NspireCXCAS-#.#... [ 1008000007206D3C3C04... |
[ TI-NspireCXCAS-#.#... @ 1008000007206D3C3C04... |
[T TI-NspireCXCAS-#.#... [ 1008000007206D3C3C04... |
[T TI-NspireCXCAS-#.#... @ 1008000007206D3C3C04... |
[ TI-NspireCXCAS-#.#... @ 1008000007206D3C3C04... |
[T TI-NspireCXCAS-#.#... [ 1008000007206D3C3C04... [
[T TI-NspireCXCAS-#.#... [§ 1008000007206D3C3C04... |
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Startup Eﬁij

TI-Nspire™ Navigator™ System Startup
Reconnect the access point.

Connect the access point to the computer using a USB cable and
click Next.

T USB 2K To &R i1 & 5 iH SEHLE
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o) WERALLBACT & IR ST - 18T RN E A BT & R i
THENL . 55 RN B EE TS .

signallight

powerlight

TI-Nspire™ Navigator™ 75 28 ¢ F & TI-Nspire™ CX Navigator™ JE 26 # 18 T &

ﬂ‘: QD%?’#T — o Bl AR B E R TE A R WCT &, W B OR B R
. %Iﬂ«’éawfcfu S, O W I R B G B F

2. BEHET—%,

BRI T 2k BT B R AG & TE 2k BT B I AR RRA . R
IR [ A RRCAS TR, U 2 BT [ A

W AR BT B R 2 TR 60 Fh Bl .

BERFR! EH AT, 1 2015 1k 3R R sl T B O & .
e RN, B R e AR B D E R O B R BRI

o WRAFEBEM G, YA PR GRS A 24 0T v B sk AT B .

5

% & TI-Nspire™ CX Navigator™ 5 4t



Configuring the Access Poi =]

Setup Complete
Your TI-Nspire™ Navigator™ system setup is complete.

The access point is configured with a classroom network. To make changes or to set up a new classroom network, go to
Tools = Network Manager and then click Network Setup Wizard.

(#) Back up my class network

Backing up your class network allows you to reload it later, if needed.

() Skip Backup

o WRAGFAAEHEMGE, BAREN TR S8 PR S R E
3. EFE AR BRI 48R O HUE N 4 L B R AT

TRAT K P 28 45 S 9 R HE o2 % 7 o 1D B 3R 48 4 R AR R U &
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[ SR R, R R R AR R G R AE .
05 Warning (=]

@ Access Point (AP) Update Failed

The AP firmware did not successfully update. The following step
may resolve the update issue you are experiencing.

Disconnect and reconnect any cables connected to the AP.

If this does not solve the issue, please contact customer support
at www.education.ti.com for further assistance.

Close
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Identify Handheld OS Version [

Identify Handheld OS Version

Each handheld must have its latest available OS5 version to complete the class
setup. Complete the following steps to verify the OS version installed on the
handheld.

1.Press Home E& toturn the handheld(s) on.

2. Select Settings = Status.

Does the handheld have its latest available 05 version?

| Cancel || Next |

%

B E TR LR RS A,

L fi [@on) 1T IF FHF B
2. MBS RE LTI TR 4R AW 0.
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Handheld Status

Eatteries: 'IOO%

‘ersion: 5.0.0.1297
Storage Capacity: 92.3 ME
Storage Awailable: 91.8 ME

Metwork: Wireless client is not attached.

Login: Mot logged in.

3. HMAFREE LERERS 5iFENL LR RA TR .
o WIRIRMERGA N B, IEILEFER
o WRBMIERGMAAN RN, HIEES.
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3
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Class Network Name

Create a class network name that is unique and easily identifiable. Avoid
using a name thatis already used by another TI-Mspire™ Mavigator™ system
in your school.

The class network name can be up to 22 characters long, and the following
characters cannot be used: ? " § V[ ] +

TI-NAV-N- | Room 217 Hour 3 |

o

1. 7E TI-NAV-N F Bt A, g N S8 R B 20 W 4% 48 52 10 4 R
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T A R S ] B (R i — 44 R . BER N 2% A BRI K O 224N
o BFRA] SRR B A A 2 RGN RE L R R A, Bl 2 S\
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2. BETF—SRkERMLELLERT&.
—af—
3. Bl ROR L TN [R50 B B R AR .
o W TI-Nspire™ Nav |g£tor"’I TLEWT &
PLide 25 S [A] 1) #5 1F 1 i
o UIH TI-Nspire™ CX NawgatorTM T4 ™ = O T DL
35 F 2.4GHz 391 B 5%, 5GHz BB , 1B T Bl it F AR ) 9 B A3 1
v BT 1 T 45 1 20 A 22 3 0 B RROA T S
Advanced Access Point Options lij
Access Point Options
If multiple TI-Nspire™ Navigator™ systems operate in close proximity to each
other, it is recommended the access points use different channels to avoid
interference issues. Always check with your IT administrator before
changing access point channels.
Select Band: i AN
[ 5GHz = } 1
‘“ am
Select Channel: -
36 Default [«] IMPORTANT!
40 If using the 5GHz band, all
44 wireless network adapters
48 in the classroom must be the v2 model.
149
153
a igz | Cancel | Done
7 165 ~
BEFL! WRLEH TI-Nspire™ CX o4k M 45 K —v2 LR IR Bk, {577
DLk ¥ 2.4GHz B 5GHz Sl Bt . W SRIR-& 1 F 2 M B W 4% &, I 2303k %
2.4GHz S B
4. BiLiSER.
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Canfiguring the Access Paint lij

Configuring the Access Point...

IMPORTANT! Do not disconnect the access point while it Is being configured.
This may take up to <#> seconds,

- — J

B 56 R T LK 1 TR S 3
7E P 25 2 I8 1 T 26 27 7 S

TE 45 8 YL I 45 4 FRAEC B VT 17 132 5, 0 20K T 2 % 1 S 5 BB 28 10 45

J U R 2D B T R A RENBIR N AL B X B T RR R MR K

Ui E SR

o HEAY B, WHERSERETHUS, ARKTFREHHACE
B % A SEHLIO Y TR 4

o HARMEY I, WHLLEMHERETHUA.

Fll}
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Prepare Your TI-Nspire™ Navigator™ System @

Prepare Your TI-Nspire™ Navigator™ System

Perform the following steps based on your TI-Nspire™ Navigator™ system equipment.

If you have a docking station: If you do not have a docking station
+
]
ﬂﬁﬂ"-‘* I
Connect a docking station to the computer. Attach Attach wireless network adapters to THNspire™ CX handhelds.

wireless network adapters to TI-Nspire™ CX
handhelds and insert handhelds into docking

station
You can link up to 2 additional docking stations to On the handheld, choose the class network by pressing the Home
the docking station that is connected to the key BB and selecting Settings > Network.

computer using USB cables. Each docking station
must be connected to a power outlet

1. i&ﬁﬁ%ﬁﬁ%%%%&%ﬁé%ﬁ%% I e A A /BT Y, R 5 LT R —
7R “UN N TE 2R 7 i A B 4 0 4% R A5 AE

Vi T AT A 8 7 s A AT % P s e 1 AE TR B Y o ) e AR
T%?%%%ﬁﬁ% %/\%%EF *"éTﬂ%EF" BB UL 4R T 5 %6 7
! °
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Add Wireless Clients to Class Network lij

Add Wireless Clients to Class Network

If available wireless clients are not found by the access point after 6 minutes, detach
and reattach the handhelds to the wireless clients.

Select available wireless clients to add to your class network.

Available Clients: (28) Clients Added to Network: (0)
590779 =
590781 [T‘
590785 J '
590790 Add All >
590799 '
590803
590804 [ < Remove ]
ity [ < Remove All ]
590810
590812 .

NOTE: After © minutes, if one or more wireless clients in your classroom are not listed
in the “Available Clients" section, finish adding available clients above and then go to
Network Manager (Tools > Network Manager) and click "Manually Add Wireless
Clients”.

[ Help J ;Cancel Back Next

2. XA AT RS TI-Nspire™ T £ ¥ % AT 2 3% a. bl c.
a) INEEFRHIE.

b) MNFRFR&M LS, LHEE >ME. Tk &5 N
e

o) IEFENEIMI LG M L% 5 L) AR, 2R A R

3. (E“USINTC 2 T v B PE 2 N 447 R B e R A B IN I) TE 2 T i
o BLUSINPTA AU AT R 7 i, R A .
o BEUNINERE RO G, W R R AN 7 0 1D, RS W .
HREFER! SRS R )5, %7 w4 JE T YL 0 2% .

4. B TSR LR in 5 HCE M %K
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Configuring the Access Point [i]

Configuring the Access Point...

IMPORTANT! Do not disconnect the access point while it Is being configured.
This may take up to <#> seconds.

——]

WA CEEN LR E P m S E MG KRB P RN G, BB
6 B0 U HE o

Setup Complete

Your THNspire™ Navigator™ system sefup is complete.

The access pointis configured with a classroom network. To make changes or to setup a new classroom network, go to
Tools = Network Manager and then click Network Setup Wizard.

(®) Back up my class network

Backing up your class network allows you to reload it later, if needed.

) skip Backup

5. EFR A RMPEL LR Oy O N 4 L B R AT

DRAF 10 19X 265 45 8 N A BLHE TE 4% 77 B 1D B1) 3% L 00 2% 44 R A 7 ) b 3k 4
fi 308 3 A 5K

FRAT 1) I 2 L B A5 S AT 78 DL (58 FH X 2 5 10 53 B3 2N o ST BROA R A7
TE My Documents/TI-Nspire/Navigator Network 3 1f 32,

LT ORAT 2 A T EL AR A5 R, W L kI &4 .
6. PLEWLLTEMBE.
FE AT DL J5 A 0 2% 4 B 2% Dy BIE S I 465 8 I EE 22 1) O A T TG 9
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Bl A1 & B T K S

1E TI-Nspire™ CX m%ﬁ?ﬁ(}ﬂﬁ?’ﬁ:ﬂ’ﬂ Teacher Preferences( F 1k ) X 3 ) 2
ZOm i o BUM M AL TR IR % B 5% El TI-Nspire™ Navigator™ [ 4% il
MK P, AT LR 5 SIS S B P AR

£ 32 T i
1 A TR X FE A e F PR TARX .

2. i File > Settings > Teacher Preferences .( A S WE > HITEIET) .
“HONT T T 1R AR & 4T T .

Teacher Account
Username: | |
Password:

« | Addteacherto classroomview

Options

Randomize order in Screen Capture

[C] Individualize Teacher Handheld in Screen Capture

oK | Cancel

3. WM 4
4. WNE,
5. 3k B R AE #0E LT R 7S 0 T R L T
D 2R S 32 R b a4 T, R AE B0 L P R SRR O AR, OF RS R A &

YRR “ MHE % W5 ER A “ NBIE 25 v M R 7 45 A whoRe 28 510 o Wik N o B T
Fr i % B oK A R YR 10 B A .

6. 16 FF I KR 1 T LA BE LA R R AR B R, s A B A AP R R U
MANF R

o BEALIK BRI B FP o 3 FF LU T DARE AL, T AN A2 BE 2% 51 2k
F 5T P 8 ECAN s 27 2R B R o B e TOUAE 27 2B T DAL TRk, T A 2
A HER) B

o ERBEEDERHEITA AT R A 005 000k 0 DU B F R b 2
718 FT ) 57 o

7. BLWE.
& i Yl kg
1. BRI EAE N F Er i 4 & 3 E TI-Nspire™ Navigator™ [ 4% ,
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2. i File > Settings > Teacher Preferences .( A > W E > HM k) .
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2.

Logs package

Hif Yes( &) DL B LR A7 zip SCHFHIALE .

Windows® %% i & #L 28 ( Bl B R FE P ) & 4T IF . zip LAFRFTE S SessionLogs
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...\My Documents\My TI-Nspire CX CAS Premium Teacher Software\
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@ Science Nspired Exploring the Equation of a Circle
Exploring the Equation of a Circle

You will explore the relationship between right
triangles, distance, and the equation of a 2
circle. Details

Name: Exploring the Equation ofa Gi.
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orensics wi Texas Instruments 4113 934 KB Activities Exchange =
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i Measuring Segments and Angles
Z MeasuringSegmentsandAngles.tns
I@] MeasuringSegmentsandanglesStudentFile. doc

'EI MeasuringSegmentsandAnglesStudentFile. pdf
I@] MeasuringSegmentsandAnglesTeacherFile.doc
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A cone will be constructed from a circle of given radius. The object is to cut a sector from the circle and form a Files

ight circular cone of maximum volume. The volume of the cane will depend upon the angle of the sector

removed and the radius of the original circle. These variables will be determined during the project. The a 'CE_C"’B'“C“"ED"C”"E"“
calculator documnent accompanies a project assignment and explains the construction of the cone and leads (3 ProjecticeCream.doc

the student through the process of building a valume function [ ProjecticeCream.pdf

Details
Name: Screaming for Ice
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Size: 214 KB
Source: Activilies Exchange
Activity T... 120 Minutes
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Subject... Math:Calculus:Other.
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& songLi B 80% B 100% 90%
& shen Huang = 100% = 100% = 100%
£ samir Kapur E 100% (| 80% 90% 6
£ Rafe Garcia | 100% ] 100% = 100%
O 2 olvia Thompson (=] 95% (] 100% = 98%
£ Nadine Simmons B 100% (| 85% B 92%
& Waria Lopez | 95% ] 100% 98%
& Laxmi Chopra = 100% = 100% = 100%

B 1acah Maare

(1 %{ZM’F': TE T AE ) vh AT R 8 B A o B AT AR AL B SO B AR T
PL:
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Stk . 5 PEGL I BT A 2k

FURRAE . 57 (47 5“5 3 G L AR X 7 10 S0P R £ B 46 BT B RE 81 A
ST 5 9100 e AR T 1 3 1 o A 06 91 b AT TS

B by 75 S35 45 43 i 7 A AT ML 18 1 82 45 7 AT A7 2 AR 1 4 AR Ml T 2
oy E. A R AR PR L T B R 2 SO AT HE

@0 o0

@ XHEFR. LR CIEER . SRR BRI R
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== TI-Nspire™

@ FES%. WA AR AT, W BRE0. B UUE SRR
RS

207 MEMHIES) S TAEIX



AN NE LB

FE V" B A% 1B £ —AE L 5, % AR XTI . HAR Z TAEXE, &
5 B M 6 ZiU A — AN B A B tns SO

AlgebraTe... | Q1 Q2 Q3 +Points Total Poi... | % %
g—Tuta\ Possibl... 10.0 10.0 5.0 75.0 100.0 Raw Sc... Final Score

Woore, Jacob 10.0 10.0 50 75.0 100.0 100% 100% -~

Chopra, Laxmi 10.0 10.0 5.0 75.0 100.0 100% 100%

Ortega, Carlos 10.0 10.0 5.0 75.0 100.0 100% 100%

@ Lopez, Maria 10.0 9.0 5.0 75.0 99.0 99% 99%
Simmons, N... 9.0 10.0 5.0 75.0 99.0 99% 99%
Garcia, Rafe 8.0 10.0 5.0 75.0 98.0 98% 98%
Huang, Shen  10.0 10.0 3.0 70.0 93.0 93% 93%
Thompson, ...

Kapur, Samir
Li, Song
Q—Average 96% 99% 94% 743 98.4 98% 98%
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CERABEN AR A
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IR AT TR IE AE .
4. RSBSOSO I B S
5. BEHRA
IR SO TR Z B o b, B SRR S A SO B
o BB TN, I E R IA .
o b BRERTEAE LR BE ULA SCAF IR BN SO 3N Th g
B
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o BEXR. BEEZR
o FHMER. HMWERBZR(MBEKRALHER, IIHEEEA)
e AR IR A R, AT RE S BOR HEAE B

B A ARG 5

Aoy LAAE “fF Ml 4 BE WU 1 v G 58 58 A8 M g 2 2, AT AE A A AN A P
G 4 AR Ml rh B A R R 2 K. R SCHR IR T IE S B R AT RO I R e K

AR,

1. RSN R IOAT H 3 R 0 A A 0 0

2. hiHEERTR RLITH ORGSR B

3. BENE B, SR)G 4% Enter. TSN, 4% Esc.
BRI PT R B R

S mT DL g A8 A ) ) T RE A A9 0 BURUAE L ER

1. AE“] 8 A BOAT IR A HOTHE .

2. AR R TR B SR
3. BN ) ) R B RS B, SR S5 4% Enter
T 22 W ) AR 1 R B S AR A i D A, B R PR A % o R
fI15 73 Eﬁﬁ\mﬁmﬁ%ﬁﬁ:ﬁ%%ﬁiﬂ’ﬂ%ﬁ .
SRR B AV
(1, FERREATRT B S -
O REVEEAESFE
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A TMR T EH -
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Lo AR NAR M RE B e, 3 36 1 22 4 48 3L 0 B 22 2
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S

e mr DL I 2% 4 A S IS B ST AR X RO A R AR Y A 0
1. MFIRPEFE AR,

AT SO > H B B

EFFHLWRE.

5 B o U AE B R AT OT

o BRINGLE OB I TR ST R

NSNS

KA T VE 2 BRI T, ST RE S EOR 2 BT
M B Gt AR X7 5 o v ‘
57 A T AR b B4 A L 4 0

&

1
DX B 31 3 4 747 LA AR ) BT A S RAT o R R
80, W ovs ST R 20 BT

II

w N

Export Data

Save In: Wl Desktop - S B

| Downloads

| Khronos

| PersReferencelnfo

| TortoiseSVN

i, ClassRosterMGentry3.csv

File Name: IAlgebra 101 - MGentry.csv

Files of Type: [CSV File (*.csv) - |

Save Cancel

4. FMEEERE MM E.

5. BRI

B X2

femr DLl I g ST 7 4 BE
WHEARE S IRAHED, LS
1. B SO>S B8R Bl o

2. EFHENXRH.

g1 o XX A H W
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“HH SE S R O AR BE BT T

Custom Export

Select an assignment. You may select multiple assignments.

Algebra 101 - MGentry, QP Set 1, 11-16.tns
Algebra 101 - MGentry, QP Set 1, 11-02.tns
Getting Started 3_0

| Select Al | | Clear All |

| Export || Cancel |

3. BBEHEFHIML,
o SR L 4B 5 B SR AE
o Pl A AR L
ol S RN BRI PR S A
4. HEGH.
5 B R U AE AT
o BRI IR0 SRS A
o BOAGRRRMELI AR
5. S BRSO LR
6. MR
Xt 35 B G T TAE X7 B 15 B AT HEF
1 ST A T 10 5 0 51 4 A
PG 5 1 912 T 40 7 I W 0 7 2 0k 4 D0 S0 47 Y
2. U F 516 LA 4 DL AT S
ITFFR A TAE X F 1935 3 46 it T H

{45 T DATE SRS T A X 7o 4T TF Lt SO 8 0388 47 S48, s 2 1 8 3 T2 X 7
AT s S A B DL R 2R ER B DA

S TAER"HITFF B E
1 R EAT T SO .
BATITPT A A 1 S0
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NI R

1535 18 TI-Nspire™ Fﬁﬁﬁﬁf SEELEAF T A LA B2 DR A7 0,
I 48 5t vy B Atk A A T ™ B HE | TI-Nspire™ CX |1 ufﬁ%&‘ TI-Nspire™ App
for iPad® 1Y i FH & it 1 ;j: 'S_f DLt iE £ TI-Nspire™ 14 5 17 & tns K & o

.tns SCAF B 2/ T H & 47 BUR & 1) MyWidgets & B3 .

T mr Dot/ TR A R

o BRAWM TSR

o N AT 4R A RS (4]l TE S5 N B /) T 8 48] :Stopwatch.tns)

o PR K £ A7 1Y B RS N SO A

Bl /N T HEIRE, TI-Nspire™ CX {8 & ff B 45 25 — BB L ans 1 &, RAB NG 34
6 4 N T8 B E S

BvV/ILR

SR A7 B B B FE E 1 MyWidgets & L AR IRy, R & i A & b TR TERR
HIALE W R

o Windows®: 3% ) 3C #F\TI-Nspire\MyWidgets.

e Mac®: 4 /TI-Nspire/MyWidgets .

o B MyWidgets

e TI-Nspire™ App for iPad® Hil TI-Nspire™ CAS App for iPad®:MyWidgets

ﬂ% MyWidget %k} 316 B 2 A0 B, 86 ZHAE B R /N T R Z B L2 B

FER B /N T H By, TI-Nspire™ CX {1 & i B 4 26 — HIEHUW tns B %, R 1%
ﬂ%%#%ﬁA‘HﬁEﬁEﬁITﬁF

I
97 SCR4 V5 A0 B
L ATIF— AR
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2. i Add Widget( i Il /MR ) .
1 Add Calculator
i 2 Add Graphs
3 Add Geometry
B 4 Add Lists & Spreadsheet
) 5 Add Data & Statistics

6 Add Notes

7 Add Vernier DataQuest™

58] 8 Add Widget

[ 9 Add Program Editor 3

3. BB LT HE ik tns SCAE
4, M.
{EER’

Widgets

stopwatch

Add Cancel

VD ST T tns STAF o AT AT GR AT 1 tns SCAF#RRE 278 78 B 31 3R

0:00:00.00
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A SO N R
1. i Doc > Insert > Widget( SC 14 > #i N\ > /NEF) o
m

1 1 Problem

482 Page (Ctrl+1)
F'l‘j’ 3 Calculator
E.d't 4 Graphs
View g Geometry
Insde Lists & Spreadsheet
7Pagi7 Data & Statistics
Refrg Notes
Settig Vernier DataQuest™
Log e

Pres g program Editor v

u & w o =
X

B0 £ Q| [
OC OO UE WRN =

»
E

2. HEHMW.

“BAR’

Widgets

stopwatch

Add Cancel

w N =

0:00:00.00

AR AT DUAE ) Insert( 4 ) 3L, 1ADHT SCRE S SCRE R NN T -
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i F D LA

TE*TEL

E ¥ % [MyDocument] > [MyWidgets].

By A\ /N TR 44 7

1 Save TI-Nspire™ Document ==
Saveln: [ )| MyWidgets -l Bdm [BE
‘E stopwatch.tns
File Name: |Newlidget ]
Files of Type: |TI-Nspire™ Documents (“tng) -]

save | |- Cancel |

T I#FE]-
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— /> TI-Nspire™ SCHS, B & T 2 5E NN RV R . BN P

o> E{m

e FH T B A ) /0 (AE A AT SO0 1A ) 1 AR R BRSO R
F\ﬁ%"f %{#&E AT SRS U5 1) 4“ £ % 7] DL 4 H I E TI-Nspire™ Catalog
Bldn, 38 )& E A L EFE KR 3L diagwithtrace() A1 FA f JF B 3L errmsg() 1
ﬁlﬁl matrix.

PR 2 diagwithtrace() S 7= 0 B (19 5 AR 28 90 1F BZ A BE B0 . a0 S NN
AR, % E 2 errmsg(), b«lfrlfilﬁli‘ﬁf‘ﬂ’ﬁm%? FFH

Faodr ®H
=T >U

Define LibPub diagwithtrace(m)
Func
f dlagwlﬁltracel:mm]: diagonal with trace
]t'm".\'l‘.lim'::m] = cn]l‘.liml:m] Then
Return t'rrms_&.{"nul__squ:m"']
Else
Dvisp diag/m)
Fetumn lrd.tl.'|:]'.lr
EndIl [iefine LibPriv errmsg|msgrode)
Fune
& Private library function erﬂﬁsg{m::mw&-]

Il msgeode "not_square” Then
Retum " Error: matrix is not square”
EndIf
EndFunc

SRJE G T DAAE A BLT 09 7 X A A T S5 i e e SO AR L

m:

matrix\diagwithtrace (m)

61 2 JE A E X B

DR AF B 1) B 45 58 P SC AR e i SORRE A R PR o BROA L B
¢ Windows®: My Documents\TI-Nspire\MyLib

e Macintosh®: Documents/TI-Nspire/MyLib.

o THFBLH: Mylib

ﬂﬂﬁ'ﬁﬁfJ\UﬂHW’%T Z SCAT S, D) 25 EE T 1) A e s A P

&y U\fﬁﬂﬂﬁirﬁiﬂ%ﬁlfﬁﬁrﬂ%ﬁirEXﬁﬁ%ofﬁXﬁgiﬂZ‘ﬁﬁfﬁﬂﬂ
Deflne i AT ' X, Hh ZiAr F B SCRY B 28— A 1a) g A,
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VERE: W1 L H e T g A SUPE B KRR T, A A0 AUAF il 12000 BT IR AF L
ﬁ RAF SR 2 AN R AT 25, 8 5 WSO 1 e o

FE SCRY AN X B A i 4 PR

o JEXHEAFRLIIE 1E] 16 N TR KKA MRS, JFHARE S A
LRI 2R sk .

o JEXRAFRLIE 1E] 15 D FRHKKA MRS, JFHARE S A
LRI 2R sk .

B R AFEEX R

SESUE T G, B2 e AFAA (LibPriv) iE f& A 3 (LibPub).

Define a=5
a RNREFEX %,

Define LibPriv b={1,2,3}
bRMAPEX G .

Define LibPub funcl (x)=x"2 - 1
Suncl 2N FLEX R

FH EX R A4 EIRTE Catalog H, mﬂ@ﬁ%AE%%%wmoﬂﬁw%%
%%ﬁ%i\ﬁ%ﬁﬁﬂm%w%% W R B Sk A St e B R
3}

O3 36 E St B AE R 3 S B 2R 7E Catalog B JFE R T -E vb . & 7 LLIE i Catalog BY
BN H AR R VT )AL PEST 4.

%;;antosh® £ LA FRETER AR, RSO AR A RER &9 R 747, i 81 04
) N

HE: f@w‘m;@a@%ﬁrﬂnmw, Catalog "' % b Prgm = Func 17 2 J&
AQKJJ R NERBAT (©), 1E 9T B . @A) DLTE I Ak B s A R R 25 1S

+H
X

EmH

55 P 08 44 FR A& 44 R

T;EXXT%E’J?FHHIEH A, R AT LA B I 3 i N R R B (R R
Define iy % $i2 ik (1 44 7K )ﬂ%w 8o X ARG DUIE T T E xR, B
A A FEREE X 5

$45 T DA 3o AR 5K 4% R A SR V) P 5 K 44 B e UL B xR

P SR 10 4 B« R4\ R 5 0 4 B o 01, 75 e SCRY tibd T E X funct
B 10 K % B TibA\funcL. 7 55 4 E BN\ AT, 4 (o) (5.

VERE : 01T VA (LA G U O 4% PR A R, 6 T AT JF
I LA 28 50 0 - 30 DL gtV 45 444
& %l R
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